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1 Definition: Was ist Sicherheit?

Es gibt einige Definitionen von Sicherheit, je nachdem von welcher Fachrichtung
man ausgeht. Im Bereich der IT-Sicherheit haben wir es jedoch nicht mit Sicherheit
im mathematischen Sinne (p=1) zu tun, sondern eher mit einer subjektiven und
nur sehr schwer messbaren Sicherheit.

In unserem Falle kbnnte man Sicherheit definieren als "In Erfahrung gegrindetes
und sich bestatigendes Gefuhl, von gewissen Gefahren nicht vorrangig getroffen
zu werden".

Sicherheit kann nicht umfassend und ohne Ambiguitdt definiert werden. Gerade
deshalb ist es wichtig die Grunds&tze der [T-Sicherheit zu kennen:

Es gibt keine 100%ige Sicherheit

Sicherheit kann nie bewiesen werden, sondern nur Unsicherheit

Sicherheit ist nicht das Ziel, sondern der Weg

Schutzmassnahmen sind eine Kosten-/Nutzenrechnung: Gegen wen will

ich meine Informationen schitzen und was ist sie uns / einem Angreifer

wert?

» Eine Schutzmassnahme sollte nicht mehr kosten als das, was ich schitzen
will wert ist (kbnnen auch subjektive Werte sein)

» [T-Sicherheit wird beeinflusst durch Menschen, Prozesse und Technologie

Die starke Verbreitung des Internet und der breiteren Verflgbarkeit von Hacker-
wissen hat dazu beigetragen, dass ein Angreifer heutzutage wenig Aufwand hat
um Angriffe starten zu kbnnen. So enthalten vermeintlich uninteressante Ziele be-
reits ein Angriffspotential, weil es schlicht trivial geworden ist, toolbasierte Ha-
ckerangriffe Uber das Internet zu starten.

2 Gefahren / Problemfdlle

Neben dem eher romantischen Bild des Hackers als rebellischem Teenager, der
ins Schulsystem einbricht um seine Noten aufzubessern, bedeuten solche Aktivitd-
ten heute eine ernstzunehmende Gefahr fur Bildungsstatten aller Stufen. Attacken
oder Missbrauch von Informatik-Sachmitteln kénnen sich auf verschiedene Arten
darstellen. Die nachfolgende Grafik zeigt eine prozentual gegliederte Zusammen-
stellung der Angriffs- und Missbrauchsarten im Jahre 2003:

Bosartiger Code (Viren, Wiirmer) 59 %
Unauthorisierter Systemzugriff

Denial of Seniice

Unerlaubter Handel (Urheberrechtsverletzungen)
Missbrauch von Scriptsprachen

Veranderte Nutzerapplikationen (Trojaner)

Veranderte Systemapplikationen (Trojaner)

Mobile Einbriiche (Drahtlose Systeme)
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2.1 Hackermethoden

Hackermethoden gibt es viele. Je nach Kenntnisstand, steht dem Angreifer eine
Vielzahl von Méglichkeiten und Tools zur Verflgung. Diese Darstellung erhebt kei-
nesfalls den Anspruch auf Vollstndigkeit und soll nur einen kleinen Einblick erlau-
ben.

Informationen Uber die Funktionsweisen des Internet und verwandter Dienste sind
offentlich und somit fur jedermann frei zugdnglich. Neben der "zivilen" Nutzung
dieser Informationen stehen diese natUrlich auch fur Hacker offen. Mit dem
grundsatzlichen Verstdndnis um die Funktionsweise des Internet wurden auch
bald einmal dessen Schwdchen offensichtlich — ndmlich das Fehlen von jeglichen
Sicherheitsfunktionen. Viele der damals eingefUhrten Protokolle, welche auf der
Internet-Grundlage Transport Control Protocol / Internet Prococol (TCP/IP) basie-
ren, krdnkeln ebenso an einem Mangel von Sicherheit.

Nehmen wir als Beispiel die folgenden Protokolle:

FTP (Transfer von Dateien)

HTTP (Transfer von Webseiten beim Surfen)

SMTP (Senden von Email Nachrichten von A nach B)
POP (Abholen von Email Nachrichten vom Postfach)
Telnet (Fernwartung von Rechnern)

Alle oben erwdhnten Protokolle haben eines gemeinsam: Sie Ubertragen Benut-
zernamen und Passworte im Klartext Uber das Internet.

2.1.1 Sniffing

Wie oben beschrieben Ubertragen die am hdufigsten gebrauchten Internet-
Protokolle Anmeldeinformationen im Klartext Uber das Internet — was uns zur wohl
einfachsten Moglichkeit eines "Hacking" bringt. Ein geneigter Hacker muss ledig-
lich mit einem "Sniffer" (Netzwerk-Abhorsoftware) an geeigneter Stelle mithdren
und kann so fast komplett ohne Aufwand Benutzernamen und Passworte prob-
lemlos abhdren. Neben Standardmdassigen Sniffern, welche hauptsdchlich fur die
legitime Fehlersuche im Netzwerk gedacht sind, gibt es auch spezialisierte Hacker-
tools — welche speziell auf Benutzernamen und Passworte im Datenstrom héren
und diese gezielt herausfiltern. NatUrlich kann man solche Tools auch nutzen um
im eigenen Netzwerk zu testen, inwiefern Passworte unverschlUsselt Goertragen
werden.

2.1.2 Malcode

Unter "Malcode" (Malicious Code) werden im Allgemeinen "bdsartige" Program-
me verstanden, welche in Form eines Virus, eines Wurms oder eines Trojaners vor-
kommen kdnnen. Naturlich sind auch Kombinationen moéglich. Viren und Wurmer
sind meist nur argerlich, kdnnen aber auch handfesten Schaden verursachen.
Nicht nur durch die blosse Verbreitung und eine eventuell damit ausgeldste "De-
nial of Service" Atftacke, sondern auch durch die Méglichkeit, dass Viren einen
Trojaner als blinden Passagier mitfUhren. Ist ein Trojaner einmal im System, kann er
dem Angreifer den kompletten Systemzugriff ermdglichen. Bekannte Vertreter
dieser Trojanerkategorie wdaren "SubSeven”, "Back Orifice" und einige andere.
Laut einer aktuellen Gartner-Studie sind 59% aller befragten Betriebe regelmdssig
von Malcode-Aftacken betroffen.
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2.1.3 Ausnutzen von Software- und Konfigurationsfehlern

Ein sehr grosses Problem beim Einsatz von Computern ist deren Komplexitat ge-
worden. Mit jeder neuen Version wird Software mit neuen Funktionen ausgestat-
tet, was auch bedeutet, dass neue mogliche Angriffspunkte entstanden sind.
Bereits muss ein relativ grosser Aufwand betrieben werden um Systeme sicher zu
machen und auch sicher zu halten.

Ein Grossteil der unautorisierten Zugriffe auf ein System kommt zu Stande weil ein
Angreifer gezielt eine Schwdche (Vulnerability) eines Betriebssystems oder einer
Applikation nutzt. Obwonhl viele Hersteller meist umgehend Korrekturen von be-
kannten Schwdchen zur Verflgung stellen, bleibt immer noch ein mehr oder we-
niger grosses Zeitfenster fur einen Angriff offen. Von der Meldung einer Schwdéche
an den Hersteller bis zur Installation einer Abhilfe auf einem Kundensystem verge-
hen Wochen bis Monate. Ganz zu schweigen von den Schwachstellen die nicht
bekannt sind. Man kann sich zum Beispiel fragen, wann (wenn Uberhaupt) ein
Hacker eine gefundene Schwachstelle dem Hersteller bekannt gibt. Vermutlich
dann wenn er sie selbst ausgiebig genutzt hat.

Die am hdaufigsten angetroffene Ursache fur unerlaubten Zugriff ist jedoch eine
mangelhafte Konfiguration von Systemen und die Nichtbeachtung von Sicher-
heitsratschldgen in den Software-HandbUchern. Software wird oft mit Standard-
einstellungen (oft auch Standard-Passworten) installiert, welche danach gar nicht
oder nur ungenugend Uberpruft und angepasst werden. Fast zu jeder verflgba-
ren Applikation kann man im Internet entsprechende Informationen nachlesen.
Diese Online-Datenbanken enthalten die Standard-Benutzernamen und Passwor-
te fur alle moglichen Software-Pakete welche auf dem Markt sind.

2.14 Web-Applikationen und -Auftritte

Viele Lehranstalten bieten inzwischen einen Webauftritt mit Informationen fur
Schuler, Eltern und Lehrpersonal. Auch die Webserver haben eine schnelle Wand-
lung mitgemacht. Von der Darstellung einfacher statischer Seiten ausgehend,
haben sich die Technologien rasant weiter entwickelt. Es sind nun dynamische
Webseiten méglich, wo der Inhalt nach Bedarf zusammengestellt wird. Diese Er-
weiterung der Webserver-Funktionalitdt bringt jedoch auch wieder eine Reihe von
Sicherheitsproblemen mit sich.

Die Zusammenstellung einer dynamischen Website bedingt, dass ein Benutzer
angibt was er will und dies dann vom Server verarbeitet und das Ergebnis dem
Benutzer prasentiert wird. Was passiert jedoch wenn man etwas eingibt was der
Webserver nicht erwartet? Ein kleines Beispiel wdare folgende URL, welche in die
Adresszeile des Browsers eingegeben werden kann:

htt p://ww. nei nesei te. ch/ cgi - bi n/ php?/ et ¢/ passwd

Wenn nun der Zielserver auf Unix/Linux I&Guft und PHP (im CGIl Mode) verfugbar ist,
wurde obiges Kommando die Unix Passwortdatei auf dem Bildschirm ausgeben,
falls das Serversystem nicht ordnungsgemass konfiguriert ist.

Neben diesem Beispiel, wo eine konzeptionelle Schwéche von CGlI (Common
Gateway Interface) basierten Applikationen ausgenutzt wird, ist auch der pro-
grammierte Code selbst ein potentielles Sicherheitsproblem. Es gibt unzdhlige
Moglichkeiten, Fehler in Programmcode fur einen Systemeinbruch auszunutzen.
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3 Sicherheits-Ratschidge / Grundschutz

3.1 Grundwissen

Um eine Technologie richtig nutzen zu kénnen muss man diese mindestens grund-
legend verstehen. Vor allem im schulischen Umfeld, wo der Lehrauftrag im Vor-
dergrund steht, werden die Belange der [T-Sicherheit oft vernachldssigt. Dies ist zu
bedauern, da gerade hier junge Menschen mit den sachgemdssen (und geset-
zeskonformen) Umgang mit Computer und Internet erlernen sollen.

Die Vermittlung von Wissen im Bereich der IT-Sicherheit an Schulen soll vor allem
Folgendes erreichen:

Fir Lehrkréfte

» Schaffen von Bewusstsein fur die Problematik der IT-Sicherheit

»  Aufbau des nétigen Grundwissens fur den Schutz der PC-Systeme am Lehr-
institut

= Sensibilisierung der Schuler fur Recht und Unrecht in der schwer fassbaren
virtuellen Welt

= Lehrkr&fte kbnnen Schuler und Eltern sensibilisieren fur die mdglichen Ge-
fahren des Internet (IT-Sicherheit aber auch ungeeignete Inhalte und ge-
fahrliche Online-Kontakte zu Erwachsenen)

= Moglichkeit den Kindern und Jugendlichen den Nutzen des PC und Inter-
net aufzuzeigen

=  Aufzeigen der Méglichkeiten wie Kinder und Jugendliche ihre Privatsphdare
im Internet schltzen kénnen

Fir Eltern
= Eltern sollen Einsch&tzen kdnnen was lhre Kinder auf dem heimischen PC
machen, was rechtens und was gesetzeswidrig ist
= Eltern sollen befdahigt werden, PCs kindertauglich einzurichten (Schutz der
Schuler soll nicht an der Schulpforte aufhéren)
» Schaffen von Bewusstsein fur die Problematik der IT-Sicherheit

Fiir Schiiler

= Nd&herbringen der Technologie
Schaffen von Bewusstsein fur die Problematik der IT-Sicherheit
Vermitteln von "Netiquette" und Online-Verhaltensregeln
Schaffen von Bewusstsein fUr Recht und Unrecht mit den neuen Medien
Vermitteln von Nufzen und Gefahren von PC’s und Internet

3.2 Konfiguration

In Bezug auf die IT-Sicherheit ist eine saubere Konfiguration einer Informatik-
Komponente, sei dies nun ein Netzwerk-Switch, ein Access Point fur Wireless LAN
oder ein PC, schon der halbe Weg zu einem sicheren System. Es gibt beim Aufbau
und bei der Wartung einer Computer-Infrastruktur einige Grundregeln, welche
helfen kbnnen:

» Nichts installieren was nicht benétigt wird
Viele Applikationen, welche auf dem Markt erhdltlich sind bieten sehr viele

Optionen welche ein Benutzer fast oder gar nie bendtigt. Fur ein sicheres
System gilt der Grundsatz, nichts zu installieren was nicht bendtigt wird. Je
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kleiner und Ubersichtlicher die installierte Basis ist, desto einfacher ist diese
zu schutzen und desto weniger Angriffsfiiche bietet diese fur einen An-
greifer.

Schauen Sie sich die Optionen, welche Sie bei der Installation eines Pro-
grammes haben genau an. Ziehen Sie im Zweifelsfall die "Benutzerdefinier-
te Installation" einer vom Hersteller vorgegebenen "Standardinstallation’
vor und wdhlen Sie nur aus was Sie bendtigen.

» Prinzip des "So viel wie nétig, so wenig wie méglich”

Bei der Vergabe von Benutzer- und Systemrechten sollte nur das an Rech-
ten vergeben werden was auch bendtigt wird. Wichtig ist hier, auch Be-
rechtigungen zu Uberprufen, welche nicht offensichtlich sind (z.B. die Sys-
temfreigaben auf Windows Systemen).

Ein Fehler der oft gemacht wird ist, Konfigurationsproblemen mit der gross-
zugigen Vergabe von Rechten beizukommen. Man sieht oft Schulinstallo-
tfionen wo jeder Schuler administrative Rechte hat, was sicherlich nicht im
Sinne des Erfinders (und des Lehrers) ist.

» Standardeinstellungen éndern

Standards sind nicht nur der Freund des Benutzers, sondern auch der des
Hackers. Die meisten Applikationen werden mit Standardeinstellungen
ausgeliefert, welche fur den Benutzer die optimale Nutzbarkeit aber nicht
die optimale Sicherheit bietet. Standardeinstellungen mussen Uberpruft
und gegebenenfalls angepasst werden.

Vor allem vom Hersteller vorgegebene Standardpassworte mussen sofort
nach der Installation eines Systems gedndert werden.

= RTFM

Bitte lesen Sie die HandbUcher lhrer Systeme — mindestens den Teil zum
Thema Sicherheit. Handbucher von Computern und Software fristen oft
ein einsames Dasein im Regal oder wandern schon bei der Lieferung in
den Papierkorb. Ich verstehe jeden der nicht gerne Handbucher liest, es
kann jedoch massgeblich zur Sicherheit Ihrer Systeme beitragen. In fast al-
len Fallen enthalten die Dokumentationen ein Kapitel Uber Sicherheitsfunk-
fionen und -einstellungen. Nutzen Sie diese Informationen.

3.3 Harten der Systeme

Das "Harten" der Computer im Schulbetrieb kann bereits wesentlich zur Erhbhung
der Sicherheit beitragen. Die nachfolgenden Kapitel sollen, pro Systemwelt, kurz
aufzeigen was die wichtigsten Schritte fur ein grundlegendes Hardening sind. Aus
Platzgrinden kann hier nur auf die wichtigsten Punkte eingegangen werden. Die
gelisteten Internet-Links verweisen jeweils auf weiterfUhrende Informationen.

3.3.1 Basishérten von Windows Systemen

Das harten von Windows Systemen ist, aufgrund der unzdhligen Schwachstellen
welche in der Vergangenheit und Gegenworr aufgetreten sind, kein leichtes Un-
terfangen. Nachfolgend wird nur ein Uberblick dargestellt. Einige Links verweisen
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fur interessierte Windows-Administrationen auf gute Informationsquellen zum The-
ma.

Zur Einstimmung soll nachstehend kurz gelistet werden welche Microsoft-Tools in
Moment die Top 10 Schwachstellen nach Meinung des FBI und des SANS-Institutes
darstellen:

1. Internet Information Services (IS)

2. Microsoft SQL Server (MSSQL)

3. Die Windows Systemauthentifizierung

4. Internet Explorer

5. Windows RAS (Remote Access Services, Fernzugriff, meist mit Modems)
6. Microsoft Data Access Components (MDAC)

7. Windows Scripting Host (WSH)

8. Microsoft Outlook / Outlook Express

9. Windows Peer to Peer File Sharing (P2P)

10. Microsoft SNMP (Simple Network Management Protocol)

Die Liste zeigt bereits deutlich eines der grdssten Probleme, welche zu einem
Grossteil fur die permanent aufkommenden Schwachstellen bei Windows Syste-
men verantwortlich sind: die tiefe Integration der Microsoft Applikationen und
Services mit dem Betriebssystem.

Nachstehend soll auf das aktuellen Client-Betriebssystem der Windows-Reihe kurz
eingegangen werden. Die Server-Versionen von Windows wlrden den Rahmen
dieses Artikels sprengen.

Links zum Thema: http://www.sans.org/top20/top20-v40-german.pdf

3.3.1.1 Allgemeines - Patch Management

Einer der wichtigsten Punkte bei der Sicherung von Windows-Systemen ist das
Patch-Management. Nachdem in den letzten Monaten etwas Ruhe eingekehrt
ist, werden nun wieder fast auf tdglicher Basis neue Sicherheits-Updates zur Verfu-
gung gestellt. Wahrend sich die Updates fur nicht kritische Einzelgerate relativ gut
automatisieren lassen, muss man fur die Server und Computerzimmer etwas mehr
Aufwand betreiben.

Updates und Patches automatisieren

FUr das Patch-Management in Schulen bieten sich die "Software Update Services"
von Microsoft an. Das Tool ist kostenlos bei Microsoft erhdltlich und kann als zent-
rales Update- und Patch Management System betrachtet werden. Der Vorteil hier
ist vor allem in der zentralen Konfigurationsmaoglichkeit zu sehen und der einge-
sparten Bandbreite — die Patches mussen nicht mehr fur jedes System vom Inter-
net heruntergeladen werden sondern nur einmal. Die Verteilung auf die Rechner
im Computerzimmer erfolgt dann Uber das interne Netzwerk. Es I&sst sich ausser-
dem festlegen, welche Sprachen und Windows-Versionen man Uberhaupt in Be-
tfracht ziehen will.

Eines ist jedoch eminent wichtig: Erst Testen, dann installieren. Es kommmt immer
wieder vor, dass sich Fehler in Sicherheits-Updates oder Service-Packs einschlei-
chen, welche dann mehr Schaden verursachen als der Virus vor dem Sie hdtten
schutzen sollen. Es empfiehlt sich hier, auf einem nicht-kritischen System zu testen,
und dann erst in die Breite auszurollen.
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Links zum Thema:
http://www.microsoft.com/downloads/details.aspx?displaylang=en&Famil
vID=A7AAQLEA-6EA1-4F54-972C-AE66A4EABF6C

Feststellen des Status Quo

Microsoft bietet fur die Analyse des Sicherheits- respektive Patch-Status von Win-
dows Systemen einige nutzliche Tools an. Einerseits ist dies der MSBA (Microsoft
Baseline Security Analyzer) und andererseits das "Office Update Inventory Tool".
Der MSBA kann ein einzelnes System oder eine Reihe von Systemen in einer Do-
mdne auf Ubliche Fehlkonfigurationen und fehlende Sicherheits-Patches hin un-
tersuchen. Das Tool bietet eine graphische Oberfl&iche, ist aber auch in einer
Kommandozeilen-Version verflgbar (fur Hardcore-Admins).

Rein fUr das Office Umfeld bietet sich das "Office Update Inventory Tool" an, wel-
ches einzelne Systeme oder ganze Netzwerke auf den Update-Status der installier-
ten Office-Pakete hin untersucht. Das Tool zeigt an was installiert und was an
neuen Updates verfugbar ist.

Links zum Thema:
http://www.microsoft.com/technet/security/tools/mbsahome.mspx
http://www.microsoft.com/office/ork/2003/journ/offutoolv2.htm

3.3.1.2 Windows XP Professional

Filesystem Sicherheit

Windows XP bietet nach wie vor die Mdglichkeit, Laufwerke mit zwei Arten von
Dateisystemen zu formatieren: FAT32 und NTFS. Aus Sicht der Sicherheit sollte auf
jeden Fall NTFS verwendet werden, da dieses massiv bessere Sicherheitsfunktionen
bietet. Ein Wehmutstropfen bleibt: Wenn Sie beispielsweise Linux parallel auf ei-
nem Window XP System mit NTFS Festplatten betreiben, kbnnen Sie von Linux aus
nicht so einfach schreibend auf die NTFS Partition zugreifen.

So prufen Sie, welches Filesystem Sie verwenden:

Einloggen mit administrativen Rechten

Doppelklick auf "Mein Computer"

Rechts-Klick auf das zu untersuchende Laufwerk

Anwdhlen von "Eigenschaften”

Die erste angezeigte Seite zeigt das Dateisystem an (z.B. "Dateisystem:
NTFS")

ORrLN =

Falls Sie noch FAT oder FAT32 Partitionen verwenden kénnen Sie diese wie folgt
konvertieren:

1. Anwdhlen von "Start" und "AusfUhren”

2. Eingeben von "cmd" und OK klicken

3. Im Shell-Fenster folgendes eingeben: convert c: /FS: NTFS /V (als Bei-
spiel fur das c: Laufwerk)

4, Enter-Taste drlcken

5. Fur dlle zu konvertierenden Laufwerke wiederholen

6. Reboot des Systems
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Achtung: Bei solchen Aktivitaten sollte immer zuerst ein Backup des Systems er-
stellt werden.

Abschalten von automatischen Logins

Kein System im Schulbetrieb sollte auf automatische Logins eingestellt sein. Einer-
seits aus Sicherheitsgrinden und andererseits um die Lernenden gleich die Nut-
zung von Sicherheitsmechanismen nahe zu legen.

Falls automatische Logins verwendet werden, kbnnen diese wie folgt beschrieben
deaktiviert werden:

1. Auswdhlen von "Start > Performance and Maintenance - Administrative
Tools > Local Security Policy

2. oder fur "Classic View”: "Start > Settings > Control Panel - User Accounts

3. Nun ist sicher zu stellen das alle lokalen Benutzer mit einem Passwort aus-
gestattet sind

Sobald ein Benutzerkonto ein Passwort gesetzt hat, ist ein automatischer Login
damit nicht mehr méglich.
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Lokale Security Policies

Dieser Abschnitt beschreibt die mdglichen Sicherheitseinstellungen, welche in den
Lokalen Sicherheitsrichtlinien getroffen werden kénnen. Falls Ihr System in einer
Windows Domd&ne (mit Active Directory) integriert ist, kbnnen die gelisteten Einstel-
lungen auch in einen "Group Policy Object" (GPO) gespeichert werden. Die Nut-
zung von einer Domdne und deren Sicherheitsfunktionen ermdglicht eine zentrale
Verwaltung von Sicherheitsrichtlinien fur alle angeschlossenen Windows-Systeme.
Die Handhabung der Sicherheitsrichtlinien lokal oder in einer Domdane sind sehr
ahnlich.

Zugriff auf das "Local Security Policy Editor Tool" erhalten Sie wie folgt:

1. Auswdhlen von "Start & Performance and Maintenance - Administrative
Tools > Local Security Policy

2. oder fur "Classic View”: "Start > Settings > Control Panel > Administrative
Tools > Local Security Policy”

Das Local Security Policy Editor Tool erlaubt eine Vielzahl von Einstellungen in Be-
zug auf die Sicherheit des lokalen Systems. Es empfiehlt sich, die Moglichkeiten
der Policy genau zu studieren.

& Local Security Settings

File Action Wiew Help
& %

I@ Security Settings Policy

Security Setting

= @ Account Policies

@Enforce passward history
Mazximum password age

1 passwords remembered
42 days

5 - @Mln\mum password age 0 days
0 [%a'lpg_tcfsl_ @Min\mum password length 0 characters
+ udit Palic
Y @Password musk meet complexity requirements Disabled

+-(_8 User Rights Assignment
+-(J8 Security Options
w27 Public Key Policies
#-[_7] Software Restriction Policies
+ ‘g IP Security Policies on Local Computer

Store password using reversible encryption for all usersi... Disabled

Mindestens die "Password Policy" und die "Account Lockout Policy" sollten ent-
sprechend eingestellt werden.

Ein kleines Wort der Warnung: Es kann passieren, dass man sich — auch als Admi-
nistrator — selbst komplett aus dem System aussperrt. Im Zweifelsfall also besser
Nachlesen oder -fragen.
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Default Benutzerkonten

Im Standard wird ein Windows XP System mit einem Administrator und einem Gast
Konto ausgestattet. Da jeder weiss wie diese Benutzerkonten heissen, ist es rat-
sam, diese umzubenennen. Noch wichtiger ist es allerdings, fUr das Administrator,
wie auch fur das Gast-Konto starke Passworte zu verwenden. Es wird empfohlen,
ein starkes Passwort fur das Gast-Konto zu setzen und dieses dann wieder zu deak-
tivieren.

Leider IGsst Windows XP nicht zu dass man das Gast-Konto gleich ganz I6scht. Auf
jeden Fall sollte das Konto deaktiviert bleiben (siehe Abschnitt "Dateizugriff und
Freigaben").

Dateizugriffe und Freigaben

Wenn man die Rechtevergabe bei Freigaben betrachtet, macht Windows XP
keinen guten Job in Punkto Sicherheit. Wird ndmlich ein neuer Share (beispielswei-
se auf das Stammverzeichnis des C-Laufwerkes "C:\") erstellt, erhdlt die Gruppe
"Everyone" vollen Zugriff darauf. Ist nun das Gast-Konto aktiviert, hat auch dieses
(als Mitglied der Everyone-Gruppe) vollen Zugriff. Nicht sehr vorteilhaft aus Sicht
der Sicherheit.

Bei der Verwendung von Freigaben muss unbedingt darauf geachtet werden,
dass eine klare Zugriffsregelung besteht. In den seltensten Fdallen sollte der Gruppe
"Everyone" Uberhaupt Zugriff auf einen Share gegeben werden. Hier gilt wieder-
um der Grundsatz "So viel wie nétig — so wenig wie moglich”,

Eine Spezialitat von Windows sind die so genannten "System Shares"'. Windows legt
fUr jedes der im System vorhandenen Partitionen (z.B. C:, D: oder E: fUr ein CD-
ROM) einen "System Share" an. Diese Freigaben kdnnen aber auch von Benutzern
verwendet werden, und zwar wie folgt:

1. Klick auf "Start > AusfUhren”

2. Eingeben von "cmd" und Enter-Taste dricken

3. Geben Sie \\ I hr _conput er nane\ c$" ein und dricken Sie die Eingabe-
taste

Dies funktfioniert naturlich auch Uber das Netzwerk. Ersetzen Sie einfach
'Inr_computername" durch den Namen eines Rechners im Netzwerk und Sie kdn-
nen auf das Laufwerk zugreifen. Je nachdem wie die Rechte des Zielsystems ein-
gestellt sind, erfolgt nicht einmal mehr eine Passwortabfrage.

3.3.2 Basishdrten von Macintosh Systemen

Up-to-date bleiben

Eine einfache Art, wichtige Fehlerkorrekturen und Sicherheitspatches moglichst
bald nach Erscheinen zu erhalten. OS X bietet Uber die Funktion "Software Up-
date" die Mdbglichkeit den Vorgang zu automatisieren. Standardmdssig wird
"Software Update" wdchentlich automatisch gestartet, dieser Wert sollte bei ex-
ponierten Systemen jedoch auf einen klrzeren Zeitraum (Taglich) gesetzt werden:

1. Click auf "System Preferences" - "Software Update " (Tab)

2. Andermn des Defaultwertes von "Wéchentlich auf "Taglich'
3. Verlassen der "System Preferences’
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Achtung: Obwohl Apple sicher eine der besseren Qualitdtssicherungs-Prozesse in
der Software-Industrie hat, kbnnen sich in solche Patches Fehler enschleichen.
Daher bitte immer erst — sofern méglich — auf einem nicht-kritischen System testen.

Abschalten unnétiger Services

Mac OS X hat in der Default-Installation alle Services die auf dem "Inetd" (dem
Internet Master-Dienstprozess) laufen abgeschaltet. Falls Sie nicht sicher sind, kdn-
nen Sie diese Einstellungen in/ et ¢/ i net d. conf Uberprufen, z.B. mit einem Text-
editor oder dem Shell-KkKommando cat /etc/inetd. conf.

Betreffs dieser Default-Einstellung gibt es unter Umsténden eine Ausnahme: Den
FTP-Service kann man auch Uber die System Preferences einstellen (System Prefe-
rences - Sharing = File & Web). Hier kann die Checkbox "Allow ftp access' an-
oder abgewdhlt werden.

Falsch konfigurierte Services kbnnen grosse Sicherheitslicken im System hinterlas-
sen, daher sollte grossen Wert auf eine richtige Konfiguration nach dem "so wenig
als moglich - so viel wie nétig" Prinzip gelegt werden. Wenn ein Service 1&uft und
Sie wissen eigentlich gar nicht so richtig was er macht — schalten Sie ihn ab. Wenn
er wichtig war wird sich jenand melden, wenn nicht, hat man ein potentielles Si-
cherheitsleck gestopft.

Falls es auf einem Ihrer Systeme nétig ist, Internet-Services anzubieten, beispiels-
weise fur Webserver, FTP-Server oder dhnliches, bietet sich der Einsatz von so ge-
nannten "TCP Wrappers' an. Diese arbeiten als "Mittelsmann' zwischen der Aus-
senwelt und den System-Services und bieten eine massiv bessere Kontrolle Uber
diese als das ohne Wrappers moglich ware. So kbnnen Anfragen gefiltert werden
um beispielsweise ein "Spoofing" (siehe Glossar) oder eine "TCP Sequence predic-
tion" (siehe Glossar) zu verhindern. Bei OS X ist bereits ein Open Source Produkt
integriert, welches genau diese Aufgaben erfullt: "TCPWrappers".

Links zum Thema: http://www.hmug.org/HowTos/tcpwrappers.html

Sichere Fernwartung

Unix-Basierte Systeme bieten oft eine Reihe von Standard-Services die dusserst
unsicher sind, wie beispielsweise Telnet, FTP, Rlogin und einige weitere. Vor allem
fur administrative Tatigkeiten sollfe man auf Protokolle setzen welche eine stérkere
Authentisierung und eine Verschlusselung der Kommunikation bieten.

Mac OS X bietet von Haus aus UnterstUtzung fur SSH (OpenSSH wird mitgeliefert).
SSH (Secure Shell) ist ein Protokoll, welches sich hervorragend eignet fur die Sys-
tem Fernwartung

Links zum Thema: www.openssh.org
www.ssh.com

Personal Firewall

Der Einsatz von Personal-Firewall Software ist generell auf jedem System zu emp-
fehlen. Die Personal Firewall von Mac OS X bietet die Méglichkeit, allen einge-
henden Netzwerkverkehr zu prufen. Erlaubte Verbindungen werden durch gelas-
sen, alle anderen nicht. Die Mac OS X Personal Firewall basiert auf "ipfw", einer
Technologie, welche sich schon seit einigen Jahren auf Unix Systemen bewdhrt
hat. Das Management der Personal Firewall ist im "Sharing" Tab integriert und er-
laubt die einfache Konfiguration Uber das anwdhlen von Checkboxen zu vordefi-
nierten Services (wie beispielsweise IRC). Naturlich ist es auch mdglich, neue Ser-
vices selbst zu definieren. Zugriff auf die Firewall erhalten Sie wie folgt:

1. Offnen der "System Preferences' = Sharing = Firewall
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2. Auf "Start" klicken
3. '"System Preferences" wieder verlassen

Wem die Funktionalit&t der integrierten Firewall nicht ausreicht, sollte sich eines
der kommerziellen Drittprodukte n&her ansehen.

Links zum Thema: http://www.roadstead.com/weblog/Tutorials/firewall.html
http://www.symantec.com/sabu/nis/npf_mac/

Benutzersicherheit

Obwohl Mac OS X bereits "ab Fabrik" mit relativ guten Sicherheitseinstellungen
zum Thema Benutzer ausgeliefert wird, gibt es doch einige Einstellungen welche
angepasst werden sollten.

Root Benutzer

Mac OS X hat bei Auslieferung den "Root" Account deaktiviert, jedoch hat dieser
ein leeres Passwort. Bei einer Kompromittierung eines solchen Systems ist es fur
den Angreifer sehr einfach, volle Kontrolle Uber das System zu erlangen.

Zum setzen eines Root Passwortes muss folgende Prozedur durchgeflhrt werden:

Klick auf den Finder

Auswdhlen von "Go > Applications"

Offnen von "Utilities"

Offnen von "Netinfo Manager'

eingeben eines Benutzernamen und Passwortes eines Administrativen Nut-

zers

Auswdahlen von "Security - Enable Root User"

Beim ersten Setzen des Root Passwortes erscheint ein "Netinfo Error”, der

anzeigt dass das Passwort leer ist

8. Geben Sie ein Root Passwort ein (siehe Link zu den Richtlinien fur sichere
Passworte) und klicken Sie auf "Set"

9. Nochmals das Passwort eingeben und auf "Verify" klicken

10. Auswdhlen von "Security - Disable Root User"

SIS A

NO

Richtlinien fur sichere Passworte

Obwohl es schon einige alternative Technologien zur Authentisierung gibt, ist die
Kombination von Benutzername und Passwort immer noch die am meisten ge-
brauchte Methode. Der Mensch neigt zur Bequemlichkeit und wahlt Passworte,
welche er sich einfach merken kann — wie beispielsweise die praferenzierte Fe-
riendestination, der Name des Hundes oder die Telefonnummer. Aus heutiger
Sicht sind alle diese Passworte schwach und durch ein modernes Hackertool in-
nert Sekunden oder Minuten zu knacken.

Es gibt Tricks und Tipps wie man sich ein sicheres Passwort ausdenken und sich
auch merken kann. Das hachfolgend verlinkte Dokument gibt wertvolle Tips:

Links zum Thema: http://www.digital-freedom.net (Tools 2 Password Audit-
ing)

Sonstige Einstellungen

Auto Logon
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Bei einer Default-Installation ist Mac OS X so konfiguriert, dass ein Autologon statt-
findet mit dem administrativen Benutzer der zuerst im System erfasst wurde. Zuséitz-
lich zeigt OS X alle validen Benutzerkonten im Login-Fenster und pré&sentiert nach
drei erfolglosen Versuchen einen Passwort "Hinweis". Alle diese Funktionen sind
zwar bequem fur den Benutzer — helfen aber auch dem Angreifer, und sollten da-
her abgeschaltet werden. Folgende Prozedur beschreibt die Sicherung des Login
Vorganges:

Offnen der "System Preferences > Accounts > User"

Abwdhlen der Option "Log in automatically as..."

Klicken auf "Login Options"

Setzen von "Display Login Window as..." auf "Name and Password"
Abwdhlen der "Show password hint after 3 attempts..." Option

IS

Screen Saver Passwort

In einem Raum wo sich mehrere Personen aufhalten, sollite das System jeweils "ge-
lockt" werden wenn man den Raum verldsst. Um der Vergesslichkeit vorzubeugen
kann man auch den Bildschirm-Schoner mit Passwortschutz aktivieren:

1. Klick auf "System Preferences - Screen Effects > Activation'

2. Setzen von "Time until screen effect starts” = 5 Minuten

3. Setzen von "Password to use when waking the screen effect” = "use my
user account password”

4. Klicken auf "Hot Corners” und setzen einer Bildschirm-Ecke fur die schnelle
Aktivierung des Bildschirmschoners

Open Firmware Passwort

Seit Version 10.1 unterstttzt Mac OS X das so genannte "Open Firmware Pass-
word”. Diese Funktion sollte fur kritische Systeme verwendet werden und gege-
benenfalls auch fur Notebooks. Ein Open Firmware Passwort bringt folgendes:

=  Bei gesetztem Passwort kann nur noch von der Harddisk gebootet wer-
den, welche als "Startup Disk" in den "System Preferences" angegeben
wurde. Ein booten von CD-ROM, FireWire Disk oder einer anderen Partiti-
on, respektive einer anderen Festplatte ist nicht mehr moglich

»  Das Open Firmware Passwort ist ausserdem durch die Technik der progres-
siven Verzbgerung gut gegen "Brute-Force" Attacken gerUstet

Um die "Open Firmware Password" Funktion zu aktivieren muss zun&chst die Soft-
ware von Apple heruntergeladen werden (siehe ersten Link unten). Bitte unbe-
dingt zuerst den Artikel Uber Open Firmware Password (zweiter Link unten) durch-
lesen. Die Konfiguration erfolgt wie nachfolgend beschrieben:

Herunterladen der "Open Firmware Password" Applikation

1.

2. Starten des Programmes

3. Klick auf das Schloss. Und Login mit einem administrativen Benutzer.

4. Klick auf "Change"

5. Anwdhlen der Checkbox "Require password to change Open Firmware
settings'

6. Eingabe eines sicheren "Open Firmware” Passwortes (nicht vergessen!)

7. Klick auf "OK"

8. Nochmaligen Klick auf das "Schloss" um weitere Anderungen an den Ein-

stellungen zu verhindern
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9. Applikation mit "Quit" verlassen

Links zum Thema: http://docs.info.apple.com/article.ntml?artnum=120095
http://docs.info.apple.com/article.html?artnum=106482

4 Linksammlung & Toollibersicht

Es gibt eine fast unUberschaubare Menge von nutzlichen und weniger nUtzlichen
Tools zum Thema Sicherheit. Die "DigitalFreedom” (DF) Website soll Administratoren
Sicherheits-Profis und interessierten Laien die Auswahl von guten Sicherheits-Tools
erleichtern. Die Website bietet eine kategorisierte Ubersicht Uiber eine Vielzahl von
Tools und wird in regelmdassigen Abstdnden auf den neusten Stand gebracht.

Des Weiteren wird auch eine umfassende Linksammlung und, erstmals auf dem
Internet, eine komplette Ubersicht Uber alle verfUgbaren RSS-Feeds zum Thema
Sicherheit geboten - in Deutsch und Englisch.

Unsere "Virus Watch' Seite zeigt zudem zusammengefasst die neusten Meldungen
der wichtigsten Hersteller und Virenjager zum Thema Viren, Worms und Trojaner.

www.digital-freedom.net

4.1 Allgemeine Links zu Mac OS X Sicherheit

Eine gute allgemeine EinfGhrung zu Mac OS X Sicherheit:
http://developer.apple.com/internet/security/securityintro.html

Apple Security Updates
http://docs.info.apple.com/article.html?artnum=61798

Schutz des Dateisystems in der Classic Umgebung
http://docs.info.apple.com/article.html?artnum=25422/

Darwin Security
http://www.stosdarwin.org/

EinfGhrung in die Sicherheit von OS X
http://developer.apple.com/internet/security/securityintro.html

Infos zu Sicherheit des OS X
http://www.apple.com/macosx/features/security/

Mac Sicherheitsportal
http://www.macsecurity.org/

Mac Sicherheitsportal
http://www.macintoshsecurity.com/

SANS Artikel zu Mac Sicherheit
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http://www.sans.org/rr/catindex.php?cat_id=34

Sicherer Betrieb eines Apache Webservers auf MaxOS X
http://www.macdevcenter.com/pub/ct/49

4.2 Allgemeine Links zu Windows Sicherheit

[IS Lockdown Tool
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilylD=DD
EQEFCO0-BB30-47EB-9A61-FD755D23CDEC

URLScan Security Tool
http://www.microsoft.com/downloads/details.aspx?FamilylD=12244f33-a5da-
4203-a3a8-83f4388bb7 1f&DisplayLang=en

NTBugtrag

NTBugtraq ist eine Mailling Liste zur Diskussion von Sicherheits-Exploits und Bugs in
Windows NT, 2000 und XP und weiteren Applikationen.
http://www.ntbugtrag.com/

Windows Security Guide

Der Windows Security Guide enthdlt Informationen und Ressourcen zur Sicherung
des Windows Betriebssystems und Details zu den aktuellsten Schwachstellen, de-
ren Behebung, Artikeln und technischem Support.
http://www.winguides.com/security/

Microsoft Sicherheits-Portal
http://www.microsoft.com/germany/ms/security/default.mspx

4.3 Kontakt / Experten-Chat

Fragen und Anregungen zum Thema Sicherheit und zu diesen Seiten nehme ich
sehr gerne entgegen. Im Sinne der Weiterentwicklung dieser Seiten bin ich um
jede ldee froh, wie diese Seiten erweitert und attraktiviert werden kénnen. Teilen
Sie uns mit was Sie weitergehend interessiert.

Bei genluigend Interesse sind wir bereit, unsere Experten fur Fragen zum Thema "Si-
cherheit im Bildungswesen' zur VerfUgung zu stellen. Dies kdnnte in der Form eines
Experten-Chat oder Forums redlisiert werden. Bitte melden Sie sich bei uns falls
dies einem Bedarf entspricht.

Kontakte:
Themengebiete: Sicherheit, Educa Dossier, Experten Chat
Ansprechpartner. Dr. Michael Boni
E-Mail Adresse: mbo@shift-think.com
Themengebiete: Digital Freedom
Ansprechpartner. Carole Hofmann
E-Mail Adresse: cho@digital-freedom.net
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5 Themen fur die ndchsten Erweiterungen des Dos-
siers

Es ist geplant, das Dossier in regelmdassigen Abstdnden zu erweitern und auf dem
neusten Stand zu halten (nichts ist &lter als ein Sicherheits-Dossier von gestern).
Fehlen Innen Themen? Welche Themen hdtten Sie gerne vorrangig behandelt?
Melden Sie sich bei uns!

Themenliste:

1. Tool-Grundausstattung: Welche Sicherheits-Tools sollten mindestens einge-
setzt werden

Incident Management: Wie erkenne ich einen Systemeinbruch

Computer Forensik: Spuren sichern und dokumentieren

Sicherheit organisieren: Wie organisiere ich IT-Sicherheit in Schulen

Erste Hilfe: Konkrete Vorgehensweisen bei konkreten Sicherheitsproblemen
(Schritt fur Schritt Anleitung und Verwendung von Tools)

S S
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